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New SpatialAnalyzer Version:      SA 2012.12.06 

What’s New In SA 

  

Download:   http://www.kinematics.com/download/index.php 

  

 
 

• Stock Language Translation 
 

Five stock languages are now included with SA: 

English 
German 
Spanish 
Russian 
Chinese 

 
 
 
 
 

• Selective CAD Import  
 

For CAD formats that support part assemblies (such as CATIA’s CatProduct files), you 
Can now choose which individual components in the assembly to import, instead of  
making an attempt to import  
the entire assembly. 
Moreover, the contents of  
any CAD file being imported  
are displayed before import  
so that you can choose which  
specific items to include in  
the operation.  
 
To access this capability,  
Import a CAD file using  
Direct CAD Access.  
 
In the Direct CAD Access  
dialog, ensure that the  
Selective Import (Choose  
which Components to  
Import) option is checked.  

 

Please note: You download the actual full version of SpatialAnalyzer, but you can use only the full functionality 
if you have a actual software license key. In other cases you can only work with the SA Viewer. 
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• GD&T Improvement  
 

 Check Pre-Eval Validator 
 
 In the User Options Analysis tab, in the GD&T Options dialog  
 (accessible by clicking the GD&T Options button), a check  
 Pre-Eval Validator has been added. This performs standard- 
 specific validation checks on measurement data prior to a  
 GD&T evaluation.     
 
  The GD&T evaluation results are equivalent regardless of  
 setting, since the standards in that area do not differ. However,  
 depending on which standard is active (ASME 1994, ASME 2009,  
 ISO 1983, or ISO 2004), different checks may be performed on  
 the initial data. This may result in a check failing even though  
 it may have passed in an earlier version of SA. 
 
 Note that the None option maintains the equivalent behavior  
 of previous versions of SA. This setting is saved with the job file. 
 
 

 Evaluate All Feature Checks 
  
 A new option has been added to force a recalculation of all feature checks in an entire job. Simply select 
 GD&T > Evaluate All Feature Checks. 
 
 
 

 
• Point to Object Dimensions: Radial Offsets 
 

Point to object dimensions can now compensate for radial  
offsets in  addition to planar offsets. Simply check the Use  
Radial Offset Component option. This is useful, for instance,  
when determining the distance to an edge that was measured  
with a pin nest. 

 
 
 
 

• Set Viewpoint   (View>View Control>Set Viewpoint … ) 

 
 From Object 

 The new command aligns the viewpoint down the -Z axis of the selected object. 
 

 From Surface Point 
 You can align the view to look directly down the normal to a surface at a specific point by click on a surface. 
 The view will realign to look directly down the normal of the surface at the selected point. 

mailto:spatialanalyzer@vmt-gmbh.de?subject=UNSUBSCRIBE_SA_Release_Newsletter
mailto:spatialanalyzer@vmt-gmbh.de?subject=UNSUBSCRIBE_SA_Release_Newsletter
mailto:spatialanalyzer@vmt-gmbh.de?subject=UNSUBSCRIBE_SA_Release_Newsletter
mailto:spatialanalyzer@vmt-gmbh.de
mailto:spatialanalyzer@vmt-gmbh.de
mailto:spatialanalyzer@vmt-gmbh.de
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/
http://ims.vmt-gmbh.de/


If you don‘t like to get this newsletter in future, please click this link: Unsubscribe SA_Release_Newsletter 
 

VMT GmbH - Gesellschaft für Vermessungstechnik, Stegwiesenstraße 24, 76646 Bruchsal – Deutschland | Tel.: +49 (0)7251-9699-8333 | Fax: +49 (0)7251-9699-8491 |  

Email: spatialanalyzer@vmt-gmbh.de | ims.vmt-gmbh.de | Geschäftsführer: Dipl.-Ing. (FH) Manfred Messing | Registergericht Mannheim HRB 231601 | Ust-ID: DE 163494957 
 

© 2012 VMT GmbH, reproduction or duplication, in whole or in part, only with written authorisation from VMT GmbH. 

•  Reporting Improvements 
 

 Report Shapes 
 To help with annotating your reports, you can now draw boxes, ellipses, and lines (or arrows) directly on reports. 
 Draw in any color or using several different line thicknesses or line styles.  
 
 
 
 
 
 
 
 
 
 
 
 

 
 Report Object Locking 

 Individual items on reports can now be locked, which “freeze-dries” values and prevents those items from being 
 modified in the report designer. Simply right-click an object on a report and select Locked Object from the context 
 menu to toggle the object’s locked state.  

 
 Report Undo 

 Undo support (Edit>Undo or Ctrl+Z) has been added to the report designer.  

 
 Insert/Delete Page 

 Pages can now be inserted or deleted in an SA report. To do so, right-click in the report and choose Insert Page or 
 Delete Page. These menu items are only available if the action is possible from the right-click location. 

• Pages can only be inserted if there are no report items intersecting the horizontal line where the click was      
   initiated. 
• Pages can only be deleted if the page does not contain any report items. 

 

 Disabled Table Truncation 
 You can disable truncation on a per-table  
 basis (regardless of the Maximum Number  
 of Rows Per Table setting in the User 
 Options Reporting tab) by right-clicking  
 the table and selecting Do Not Truncate  
 from the context menu. 
 

 Remove Trailing Empty Pages 
 In the Report Designer, there is a new  
 option to remove all empty pages at the  
 end of a report. Simply select   
 Edit>Remove Trailing Empty Pages. 
 

 Colorization of In-Tolerance Fields 
 A new report option has been added  
 for coloring in-tolerance delta fields  
 green (see picture). 
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• Laser Trackers 
 

 Projection Plane Settings 

 New settings have been established for measurement operations that accept projection planes, including: 

• Circle 
• Patch Point 
• Single Point Circle 

 Left-click the projection or intersection plane option in the operation’s  
 parameters to select an existing plane to use. Right-click to specify  
 options for automatically fitting the points while measuring: 

• Regenerate in SA. This option automatically creates the construction  
   plane after the profile completes. 

• Remove from Profile. Clears an existing selected plane from the profile. 

• Fit To Points. When checked SA will automatically fit a plane to the measured points.  
   Specify the number of points to measure here. 
 

 3-Plane Point 

 This new measurement operation in the laser tracker interface automates the  
 process of measuring a “corner point” - a point that is constructed by measuring 
 3 intersecting planes. Many different acquisition modes can be used with this  
 operation, including discrete point, stable point, and spatial scan.   
 To define or measure the three planes, see above “Projection Plane Settings”. 
 
 

 Adding Targets with Custom Radial Offsets 

 When adding defined targets in the laser tracker interface using the  
 Add: From Selected Reflector button, you can now specify both the planar and  
 radial offsets. This allows you to set these offsets in this dialog instead of the  
 Targets table. 
 The default values for these fields will change depending on the size of the  
 selected reflector and your current active units. 
 
 

 Circle Fit Point on Normal Option 

 When measuring a circle in the laser tracker interface or fitting a circle using  
 Measurement Plans, the circle fit output parameters now have a Make Pt on  
 Normal option. 
  
 
 
 
 
 
 
 
 
 
 When checked (if Make Cardinal Pts is enabled), the fit will create a cardinal point on the circle’s normal 
 (existing behavior). You can now turn this option off to create a cardinal point only on the circle center. 
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•  Inspection Routine Navigation Enhancements 
You can now program function keys (or remotes that emulate function keys) for “Next”,  
“Previous” and “Stop” navigation operations, primarily to allow easier progression  
through an inspection routine in the SA Toolkit. 
You can now also program CMM arm buttons for Next/Previous to correspond to a  
short/Long button press. 

 
 
 
 
 

• Leica AT-401 Reflector Tilt Detection 
In EmScon v.3.8.290 and later, the AT401 will now detect  
that a reflector is tilted too far away from the instrument  
and return an invalid beam state, essentially preventing  
measurement. 
This feature can be enabled/disabled in the Leica 4xx  
Tracker Settings dialog as Reflector Tilt Detection  
(emScon 3.8 or higher). 

 
 
 
 
 
 

• Laser Radar: Video Source Selection 
In the Laser Radar interface, you can now explicitly  
choose the video source.  
From the interface, select Settings>Video Settings> 
Video Capture Device.  
 
 
 
 
 
 

• Leica TDA5005 GeoCOM Interface Added 

A GeoCOM-based interface has been added for the Leica TDA5005 that does  
not require the use of the NRK embedded SpatialAnalyzer application. This  
interface looks similar to the TDRA6000 interface. For this to function properly,  
the instrument must be added as a ‘Leica TDA5005 Total Station (GeoCOM)’ type. 

For the GeoCOM mode to work properly, the instrument must be in the ‘MEAS’  
program, running from its top level menu. Entering lower-level menu items  
Within the program will cause the device to cease GeoCOM communication  
until returning to the top level menu.  
The TDA5005 should be configured with GSI Communication: 9600/N/8/1/No  
Protocol and GeoCOM Communication: 9600/N/8/1/GeoCOM Protocol. 
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•  Repeat Alignments  
 
Any instrument’s alignment can now be repeated, making alignments as part of a repeatable process easier to set up.  
Whenever an instrument is aligned using Quick Align, Measure Nominal Points, or the Frame Wizard, the alignment parameters are 
stored with the instrument. This alignment can then be repeated at any time.  
 
To Repeat an Instrument’s Alignment:  
In the Inspection tab of the SA Toolkit, click the Repeat Last button while connected to an  
instrument. This will automatically recall the previously saved alignment parameters, which  
can then be modified or committed. Clicking the New button is a convenient way to perform  
a new alignment on the connected instrument. 

 
 
• Geometry Relationship Point Lists 
 
You now have access to and control over point lists for geometry relationships.  
Simply click the Point List button in the Geometry Relationship Report Options  
dialog.  
 
You can also access the point list by right-clicking a geometry relationship in the  
tree and selecting View Point List. Just as in the Geometry Fitting dialog, you can  
deactivate points, deactivate  points exceeding a critical threshold, and sort by  
name or error. 
 
A new option has been added to the Geometry Relationship Report Options  
dialog to permit the display of these points on a report. Simply  select the  
Show Point List Details In Report option, and when the geometry relationship  
is added to a report, the point list will be included. 
 
 

• MP Script 

 Searching  

The MP Editor now has a Search field which allows you to search the current  
script to find a command or comment. 

This can save a lot of time when working on a lengthy script. 

 

 The MP Editor now supports drag and drop loading of MPs from external files.  
    Simply drag an MP file onto the MP editor, and it will be opened. 
 

 A new button, Show Step References, has been added which shows the steps  
    that reference the selected step.  
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•   Events – in the past 

The 4th German User Meeting of the SpatialAnalyzer Software 

08. – 09. November 2012 | Bruchsal - Germany | at VMT 
 
This year six SA user hold presentations about their SA applications. VMT and NRK 
presented the new SA packages (see below) and organized some workshops regarding 
„Relationship Fitting“ and „Toolkit + Reporting“. Many thanks to the 45 participants at the 
German User Meeting.  We are looking forward meeting you next year again. 

SA PROFESSIONAL 
SA Professional with Native CAD is the professional measurement, alignment, inspection, analysis, and reporting 
software for all portable metrology instruments. In addition to all essential measurement needs, it includes 
several key inspection features, geometry inspection, and measurement automation. 
 
SA ULTIMATE 
SA Ultimate plus Native CAD is the premier measurement, optimization, analysis, reporting, and automation 
software suite for all portable instruments. 
 
SA MACHINE 
SA Machine with Native CAD contains all features of SA Ultimate, but also allows users to interface with 
robots and CNC machines. This permits calibration and real-time compensation of robots and large volume 
CNC machines to high degrees of accuracy. It also enables robotic scripting, teach pendant behavior, and linear 
or joint space robotic control. 
 
For more information s:  IMS Homepage 
   NRK Homepage 

•   Available SA Packages 2013 

•   Events – at the future 

CONTROL 2013  
The International Trade Fair for Quality Assurance 

14. – 17. May 2013 | Messe Stuttgart | Hall 5, Booth 5308   
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